Dos Attack in Internetworks

Software Used: NetSim Standard v12.1/v12.2 (32/64 bit), Visual Studio 2019

Follow the instructions specified in the following link to clone/download the project folder from GitHub
using Visual Studio:
https://tetcos.freshdesk.com/support/solutions/articles/14000099351-how-to-clone-netsim-file-
exchange-project-repositories-from-github-

Other tools such as GitHub Desktop, SVN Client, Sourcetree, Git from the command line, or any client
you like to clone the Git repository.

Note: It is recommended not to download the project as an archive (compressed zip) to avoid
incompatibility while importing workspaces into NetSim.

Secure URL for the GitHub repository:
v12.1: https://github.com/NetSim-TETCOS/DOS_Attack_in_Internetworks_v12.1.git

v12.2: https://github.com/NetSim-TETCOS/DOS_Attack_in_Internetworks_v12.2.git

Note: The cloned project directory will contain the documentation specific to the NetSim version
(v12.1/v12.2).

A Denial of Service (DoS) attack is an attempt to make a system unavailable to the intended user(s),
such as preventing access to a website. A successful DoS attack consumes all available network or
system resources, usually resulting in a slowdown or server crash. Whenever multiple sources are
coordinating in the DoS attack, it becomes known as a DDoS (Distributed Denial of Service) attack.

Standard DDoS Attack types:

SYN Flood

UDP Flood
SMBLoris

ICMP Flood
HTTP GET Flood
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SYN Flood:

TCP SYN floods are DoS attacks that attempt to flood the DNS server with new TCP connection

requests. Normally, a client initiates a TCP connection through a three way handshake of messages:

e The client requests a connection by sending a SYN (synchronize) message to the server.
¢ The server acknowledges the request by sending SYN-ACK back to the client.
¢ The client answers with a responding ACK, establishing the connection.


https://tetcos.freshdesk.com/support/solutions/articles/14000099351-how-to-clone-netsim-file-exchange-project-repositories-from-github-
https://tetcos.freshdesk.com/support/solutions/articles/14000099351-how-to-clone-netsim-file-exchange-project-repositories-from-github-
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This triple exchange is the foundation for every connection established using the Transmission Control
Protocol (TCP). A SYN Flood is one of the most common forms of DDoS attacks. It occurs when an
attacker sends a succession of TCP Synchronize (SYN) requests to the target in an attempt to consume
enough resources to make the server unavailable for legitimate users. This works because a SYN
request opens network communication between a prospective client and the target server. When the
server receives a SYN request, it responds acknowledging the request and holds the communication
open while it waits for the client to acknowledge the open connection. However, in a successful SYN
Flood, the client acknowledgment never arrives, thus consuming the server’s resources until the
connection times out. A large number of incoming SYN requests to the target server exhausts all

available server resources and results in a successful DoS attack.
Before implementing this project in NetSim, users have to understand the steps given below:

1. TCP Log file
o User need to understand the TCP log file which will get created in the temp path of NetSim
<Windows Temp Folder>/NetSim>

e The TCP Log file is usually a very large file and hence is disabled by default in NetSim.

e To enable logging, go to TCP.c inside the TCP project and change the function bool
isTCPlog() to return true instead of false.

2. At malicious node:

Create a new timer event called SYN_FLOOD in TCP for sending TCP_SYN packets that should
be triggered for every 1000 micro seconds. This will create and send the TCP_SYN packet for
every 1000 micro seconds. SYN request opens network communication between a client and the
target

3. At Target node:

When the target receives a SYN request, it responds acknowledging the request and holds the

communication open while it waits for the client to acknowledge the open connection. If a SYN



packet arrives at Receiver, it should reply with a SYN_ACK packet. For this SYN_ACK packet, add
a processing time of 2000 micro seconds in Ethernet Physical Out. This delays the arrival of
SYN_ACK at source node. During this delay, another SYN packet will get created at the malicious
node. A large number of incoming SYN requests to the target exhausts all available server

resources and results in a successful DoS attack
SYN_FLOOD in NetSim:

To implement this project in NetSim, we have created SYN_FLOOD.c file inside TCP project. The file

contains the following functions:

e intis_malicious_node();

This function is used to check the node is malicious node or not

e int socket_creation();

This function is used to create a new socket and update the socket parameters
e static void send_syn_packet(PNETSIM_SOCKET s);

This function is used to create and send SYN packet to the network layer
e void syn_flood();

This function is used to check whether the socket is present or not and also adds a timer event
called SYN_FLOOD (triggers for every 1000us)

Code modifications done in NetSim:

1. We have added the following lines of code in fn_NetSim_TCP_Trace() function present in TCP.c
file inside TCP project. This is used to add the SYN_FLOOD sub-events in Event Trace file

X TCP - (Global Scope)
125 to get the sub event as a string.
1286 */
127 -|_declspec {dllexport) char *fn_Net5im _TCP_Trace(int nSubEwent)
128 {
129 |  if (nSubEvent == SYN_FLOOD)
138 return "SYN_FLOOD";
131 return (GetStringTCP_Subevent(nsubEvent});
132 }

2.  We have added the following lines of code in fn_NetSim_TCP_HandleTimer() function present in
TCP.c file inside TCP project. Used to add a TCP sub_event called SYN_FLOOD



B TCP -|  (Global Scope)
286 Flstatic int fn_NetSim_TCP_HandleTimer()
207 7
2e3 = switch (pstruEventDetails-»nSubEventType)
209 {
218 |  case syn_FLOOD:
211 syn_Tlood();
212 bhreak;
213 case TCP_RTO_TIMEOUT:
214 handle_rto_timer();
215 hreak;
216 case TCP_TIME_WATT_TIMEOUT:
217 handle_time wait_timeout();
218 hreak;
219 default:
228 fnNetSimError("Unknown subevent %d in #s'\n",
221 pstrutEventDetails-»nSubEventType,
222 __ FUNCTION )3
223 hreak;
224 ol
225 return @;
226 B

3. And modified the following lines of code in fn_NetSim_TCP_Init() function resent in TCP.c inside
TCP project

Ll TCP.c = X ~
R 5] TcP v (Global Scope) ~ | @ fn_NetSim_TCP_Init(stru_NetSim_Network * NETWORK_Fort ~
‘g 79 = 3
5 30 _declspec (dllexport) int fn_NetSim TCP_Init(struct stru_NetSim_Network® NETWORK_Formal, -
: 81 NetSim_EVENTDETAILS* pstruEventDetails_Formal,
g 82 char* pszAppPath_Formal,
g 83 char* pszWritePath_Formal, L
e 84 int nVersion_Type, |

85 E  void** fnPointer)

86 {

87 fn_NetSim TCP_Init F(NETWORK Formal,

38 pstruEventDetails Formal,

89 pszAppPath Formal,

9@ pszWritePath_Formal,

91 nVersion_Type,

92 fnPointer); |

93 NetSim EVENTDETAILS pevent;

94 memcpy (&p pstr 1s, sizeof pevent);

95

96 El for (int i = @; i < NETWORK->nDeviceCount; i++)

97 {

98 El if (is_malicious_node(i + 1))

99 {

100 pevent.nDeviceld = i + 1;

101 pevent.dEventTime += 1000;

102 pevent.nEventType = TIMER_EVENT;

103 pevent.nSubEventType = SYN_FLOOD;

104 pevent.nProtocolld = TX_PROTOCOL_TCP;

105 fnpAddEvent (&pevent);

106

107 }

108 | 1

109 return @;|

110 }

111

12 G@/**

113 This function is called by NetworkStack.dll, once simulation end to free the

14 allocated memory for the network. d

= LF)
98 % 3 @ No issues found

Output - 1 X

4. And modified the following lines of code in add_timeout_event() present in RTO.c file inside TCP
project which avoids RTO timer for malicious nodes



Ll RIO.c = X -
Rl ) Tcp -] (Global Scope) 5 =
Bl 52 | *rto = min(max((*rto*2), G), (6@ * SECOND)); +
2 53 print_tcp_log("New RTO = %8.21f", *rto); 7
5 54 }
g 55 i
g 56 void add_timeout_event(PNETSIM SOCKET s,
= 57 @ NetSim_PACKET* packet)
58 {
59 NetSim PACKET* p = fn_NetSim_Packet_CopyPacket(packet);
60 add_packet_to_queue(&s->tcb->retransmissionQueue, p, pstruEventDetails->dEventTime);
61 NetSim_EVENTDETAILS pevent;
62 memcpy (&pevent, pstruEventDetails, sizeof pevent);
63 pevent.dEventTime += TCP_RTO(s->tcb);
64 pevent.dPacketSize = packet->pstruTransportData->dPacketSize;
65 pevent.nEventType = TIMER_EVENT;
66 pevent.nPacketId = packet->nPacketld;
67 =  if (packet->pstruAppData)
68
69 pevent.nApplicationId = packet->pstruAppData->nApplicationId;
70 pevent.nSegmentId = packet->pstruAppData->nSegmentId; ]
71 }
72 else
73 pevent.nSegmentId = @;
74 c] if (!is_malicious_node(pevent.nDeviceId))
75 {
76 pevent.nProtocolld = TX_PROTOCOL_TCP;
77 pevent.pPacket = fn_NetSim Packet CopyPacket(p);
78 pevent.szOtherDetails = NULL;
79 pevent.nSubEventType = TCP_RTO_TIMEOUT;
80 fnpAddEvent(&pevent);
81 print_tcp_log("Adding RTO Timer at %@.11f", pevent.dEventTime);
82 3
83 }
84
85 Sistatic void handle_rto_timer_for_ctrl(PNETSIM SOCKET s)
86 {
87 if (isSynbitSet(pstruEventDetails->pPacket))
28 rasend sun(<)- =
98%  ~ @ No issues found
Output v i
5. Users can give their own number of malicious node in TCP.h file inside TCP project
TCPh & X -
Pl Tcp ~|  (Global Scope) - o
49 //USEFUL MACRO [#]
56 #define isTCPConfigured(d) (DEVICE_TRXLayer(d) & DEVICE_TRXLayer(d)->isTCP) a
51 #define isTCPControl(p) (p->nControlDataType/188 == TX_PROTOCOL TCR)
52
53 //Constant
54 #define TCP_DupThresh 3
55 | fdefine NUMBEROFMALICIOUSNODE 2 -
56 int is_malicious_node(NETSIM_ID devid);
57 //Typedef
58 typedef struct stru TCP_Socket NETSIM SOCKET, *PNETSIM_SOCKET;
59
68  El typedef enum enum_tepstate
61
62 TCPCONNECTION_CLOSED,
63 TCPCONNECTION_LISTEN,
B4 TCPCONNECTION_SYM_SENT,
65 TCPCONNECTION_SYN_RECEIVED,
66 TCPCONNECTION _ESTABLISHED,
67 TCPCONNECTION_FIN_WATT 1,
68 TCPCONNECTION_FIN_WATT_2,
69 TCPCONNECTION_CLOSE_WAIT,
78 TCPCONNECTION_CLOSING,
71 TCPCONNECTION_LAST_ACK,
72 TCPCONNECTION_TIME_WAIT,
73 }TCP_CONNECTION STATE;
74
75 E typedef enum enum_tep variant
76
77 TCPVariant_OLDTAHOE, //Slow Start and Congestion Avoidance
78 TCPVariant_TAHOE, //Fast Retransmit/Fast Recovery L
79 TCPVariant_RENO, b
80 TCPVariant_NEWRENO,
81 TCPVariant BIC,
82 TCPVariant CUBIC,
83 FTCPVARIANT; -

6. Users can give their own target ID and malicious ID in SYN_FLOOD.c file inside TCP project



SYN_flood.c & X TCB.h -
&I TcP | (Global Scope) -| =

13 [ s =/ E3

14 -

15 El#include "main.h”

16 #include "TCP.h"

17 #include "List.h"

13 #include "TCP_Header.h”

19 #include "TCP_Enum.h” wl

28

21 Iint malicious_node[NUMBEROFMALICIOUSNODE] = { 2, 6 };

22 static void send_syn_packet(PNETSIM_SOCKET s);

23 J/static PNETSIM_SOCKET socket creation();

24 int target_node = 4;

25 PNETSIM SOCKET get_Remotesocket(NETSIM_ID d, PSOCKETADDRESS addr);

26 static PSOCKETADDRESS sockAddr = NULL;

27

28 Elint is_malicious_node(NETSIM_ID devid)

29 {

3e for (int 1 = @; i < NUMBEROFMALICIOUSNODE; i++)

31 if (devid == malicious_node[i]) return 1;

32

33 return @;

34 1

35

36 Elvoid syn_flood()

7|

E: I =

39 if (!sockAddr)

40 {

41 sockaddr = calloc(l, sizeof * sockAddr);

a4z sockAddr->ip = DEVICE_NWADDRESS(target_node, 1);

43

a4 }

45

46 PNETSIM_SOCKET s = get_Remotesocket(malicious_node, sockAddr);

47 */ =

7. Added the following line in TCP_Enum.h file inside TCP project to add a new TCP_subevent
called SYN_FLOOD

Bl

TCP_Enum.h & > ey RTO.c SYM_flood.c TCP_Connection.c

TP -|  (Global Scope)

¥0qoo]  J3i0|dxg Jamag

#include "EnumString.h™

[FIBEGIN_ENUM{TCP_Subevent)

1
DECL_ENUM_ELEMENT WITH VAL(TCP_RTO TIMEOUT, TX PROTOCOL TCP * 1@8),
DECL_ENUM_ELEMENT (TCP_TIME WAIT TIMEOUT),
DECL_ENUM_ELEMENT (SYN_FLOOD),|

1

#pragma warning(disable:4828)

END_ENUM({TCP_ Subevent);

#pragma warning(default:4828)

8. SYN_FLOOD.c file contains the following functions

Ml TP ~|  (Global Scope) =
16 #include "TCP.h"
17 #include "List.h"
18 #include “"TCP_Header.h”
19 #include “TCP_Enum.h"
28
21 lint malicious node[NUMBEROFMALICIOUSNODE] = { 2, 6 };
22 static void send_syn_packet{PMETSIM SOCKET s};
23 //fstatic PNETSIM SOCKET socket_creation();
24 int target_node = 4;
25 PNETSIM_SOCKET get Remotesocket({NETSIM ID d, PSOCKETADDRESS addr};
26 static PSOCKETADDRESS sockAddr = NULLj;
27
28 Eldnt is malicious_node(NETSIM ID devid})
29 {
38 for (int 1 = @; i < NUMBEROFMALICIOUSNODE; i++)
31 if (devid == malicious _node[i]) return 1;
32
33 return @;
34 }




-] (Global Scope) -|®@ syn_floodo

517CP -] (Global scope) | @ send_syn_packet(PNETSIM_SOCKET 5)

bk

-] (Global Scope) ~|® socket_creation)

85
86
87
88
89
%0
91
92
93
94
95
96
97
98
99
100
1e1
182
103
104
105
106
107
1e8
109
110
111
112
113
114

N

108% ~ @ Noissues found
—

9. Added PROCESSING_TIME macro in Ethernet.h file inside ETHERNET project



Enernec = > [ —
[®] Ethernet vI (Global Scope) vI

22 #pragma comment{lib,"Metrics.1ib™)

23 #pragma comment (lib,"1ibTCP™}

24 #define isETHConfigured({d,i) {DEVICE_MACLAYER({d,i)->nMacProtocolIld == MAC_PROTOCOL_IEEES@2_3)

25 //Global variable

26 PHMETSIM MACADDRESS multicastSPTMAC;

27

28 #define ETH_IFG ©.96@ //Micro sec

29

EPg #define Processing_TIME 1680

31

32 =] typedef enum enum_eth_packet

33

34 ETH_CONFIGBPDU = MAC_ PROTOCOL_TEEES@2 3 * 168 + 1,

35 | JETH PACKET;

36

37 /** Enumeraticon for Switching Technique */

33 = typedef enum enum_SwitchingTechnique

39 {

48 SWITCHINGTECHNIQUE_NULL,

41 SWITCHINGTECHNIQUE_STORE_FORWARD,

42 SWITCHINGTECHNTIQUE_CUT_THROUGH,

43 SWITCHINGTECHNTIQUE_FRAGMENT_FREE,

o | FSWITCHING TECHNIQUE:;

45

10. Modified the following lines of code in fn_NetSim_Ethernet_HandlePhyOut() function presentin
Ethernet_Phy.c file inside Ethernet project.

Eth Ethemnet_Phy.c* # X
[ Ethernet | (Global Scope) -|® fn_NetSim_Ethemet_HandlePhyOut0)
if (!packet)
return 2; // No packet is there for transmission

.h

double start;

if (pstruEventDetails->nDeviceld == target_node && (packet->nControlDataType == 40102 || packet->nControlDataType == 40105))

if (phy->lastPacketEndTime + phy->IFG <= pstruEventDetails->dEventTime)
start = pstruEventDetails->dEventTime + Processing TIME;

else
start = phy->lastPacketEndTime + phy->IFG + Processing TIME;

}
else
if (phy->lastPacketEndTime + phy->IFG <= pstruEventDetails->dEventTime)
start = pstruEventDetails->dEventTime;
else
start = phy->lastPacketEndTime + phy->IFG;
}

11. Rightclickon TCP project @ Properties@Linker @ Advanced @import library 32-bit and 64-bit
AAlib\lib$(TargetName).lib or .\lib_x64\lib$(TargetName).lib
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xoquooy o Pass

CP Property Pages X

Configution:  Active(Debug)
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Steps:

1. The downloaded project folder contains the folders Documentation, and
DOS_Attack_Internetworks directory as shown below:

| 1+ = | DOS_Attack_v12.1 — O >
Home Share View 0
[] ° Cut x - \i—l open - HH selectan
| Copy path 1= Edit Select none
Pinatcocg:lick Copy  Paste ] Paste shortcut r-.tl;-\.-'e Ct-;m-' Delvete Rename fpolled":r Propfrties B Histoy EF‘Inuertselection

Clipboard Organise MNew Open Select

<« v 4 » DOS_Attack_v12.1 w O Search DOS_Attack_w12.1 0

o) Mame - Date medified Type Size

st CQuick access

File folder

Documentation
DOS_Attack_Internetwork

[ Desktop
* Downloads

|| Documents

File folder

&= Pictures
CAPACITY ANAL
Documentation

lcons

2 items

2. Import DOS_Attack Internetworks by going to Open Simulation->Workspace Options-
>More Options in NetSim Home window. Then select Import as shown below:
|;§ MNetSim Home - *
NetSim Standard
Network Simulation/Emulation Platform
Version 12.1.21 (64 Bit)
Current workspace: NetSim_12.1.21 64 std default
MNew Simulation Ctrl+N Workspace name Location Description
NetSim_12.1.21_64_std_default C:\Users\Sagar\Documents - Export T
Cpen Simulation Ctrl+Q
Examples
License Settings
Exit
MNew Back
Support Learn Documentation Contact us
AQ User Manual Email - sales@tetcos.com
chnical Support nents Manual Phone - +1 767 605 4321
Email - support@tetcos.com
3. It displays a window where users need to give the path of the workspace folder and click on

OK as shown below:



| ?' Import Workspace

Analyse the content of your folder or archive file to find projects and import
them. Browse the respective Workspace folder and import it as a current
working Workspace. This will impeort all the folders experiments.

Impaort from

Cancel

4. Browse to the DOS_Attack_Internetworks folder and click on select folder as shown below:
?,'! Select Folder

s

<« v 4 <« Desktop » DOS_Attack v12.1 v | D Search DOS_Attack_v12.1 2

= @

Date modified Type

Organise = Mew folder

WORK FROM H( # Mame -

[ This PC Documentation

06,05/2020 09:45 File folder
8 3D Objects DOS5_Attack_Internetwork 06/05/2020 09%:44 File folder
[ Desktop

@ Documents

; Downloads

J‘& Music

= Pictures

E Videos

. Local Disk (C)

- Mew Volume (D:

[_} Metwork v <

Folder: | DOS_Attack_Internetwork

Select Folder Cancel

5. After this click on OK button in the Import Workspace window.

6. While importing the workspace, if the following warning message indicating Software Version
Mismatch is displayed, you can ignore it and proceed.

|?' Warning

Pt

Software Version Mismatch

You are importing a workspace from &4 build of NetSim into a 32
build of NetSim. After import, reset binaries for this workspace, and

then rebuild your code if you have made any changes to the source
codes,

OK

7. The Imported workspace will be set as the current workspace automatically. To seethe

imported workspace, click on Open Simulation->Workspace Options->More Options as
shown below:



[7% NetSim Home - X
NetSim Standard
Network Simulation/Emulation Platform
Version 12.1.21 (64 Bit)
Current workspace: DOS_Attack_Internetwork
Mew Simulation Ctrl+N Workspace name Location Description
DOS_Attack_Internetwork CA\Users\Sagar\Desktop\DOS_Attack... - Export |
| Open Simulati Ctrl+0
pen simulation - MetSim_12.1.21_64_std_default C\Users\Sagar\Documents Expart Tl
Examples
License Settings
Exit
Mew Import Back
Suppert Learn Documentation Contact us
Q Email - sales@tetcos.com
Contact Technical Support riments Manual Phone - +91 767 605 4321
Email - support@tetcos.com

8. Open the Source codes in Visual Studio by going to Open Simulation-> Workspace Options
and Clicking on Open code button as shown below:

[T NetSim Home — pd
NetSim Standard
Metwork Simulation/Emulation Platform
Version 12.1.21 (64 Bit)
Current workspace: DOS_Attack Internetwork C\ ‘
Mew Simulation Ctrl+ N Experiment name Date modified Metwork type
DOS_Attack_Case_3 06-05-2020 Internetworks View Results  Export il
| Open Simulation Ctrd+Q ~
DOS_Attack Case 2 06-03-2020 Internetworks V Export ]i[
Examples DOS_Attack_Case_1 06-05-2020 Intemetworks Expaort TiT
License Settings
Exit
Reset Code Reset Binaries More options Back
Support Learn Documentation Contact us
Q s User Manual Email - sales@tetcos.com
hnical Suppaort iments Manual Phone - +91 767 605 4321
Email - support@tetcos.cam

9. Under the TCP project in the solution explorer you will be able to see that SYN_FLOOD.c file.
10. Based on whether you are using NetSim 32 bit or 64 bit setup you can configure Visual studio
to build 32 bit or 64 bit DIl files respectively as shown below:



0{ File Edt View Project Buld Debug Test Anslyze Tools [Extensions Window Help | Search Visusl Studic (Ctil-Q) P Netsim ® - o5 x

f@-0|@-2 M| D¢ | Debug - x64 ~ P Local Windows Debugger ~ | 57 - |8 LiveShare &7
Win32
64 Solution Explorer T Ex
Configuration Manager.. cCo@E-o-c | L=
Search Solution Explorer (Ctrl+;) P
5] Solution 'NetSim" (2 projects) -
Pl Ethernet
b wm References
b 1 External Dependencies
€ Ethemet.c
B Ethemeth
C Ethemet_enum.c
[ Ethemet_enum.h
C Ethernet Mac.c
C Ethemet Phy.c
 SpanningTiee.c
C© SwitchTable.c

xoqjo0L sat0dig ;AS

b =B References
b 1 Extemnal Dependencies
b ¢ Congestion.c
b CuBICc

b ¢ DelayedAckc
b ¢ Roc

b SACKc

b ¢ SYNfloodc

b TBe

b @ TBh

b TP

b B TCPh

b TCP_Applicationinterface.c
3

4

b

3

b

3

b

b

b

Aannnnn

€ TCP_Connection.c
€ TCP_Enum.c
B TCP_Enumh
[ TCP_Headerh
€ TCP_Incoming.c
TCP_Networkinterface.c
TCP_Outgoing.c
TCP_Packet.c
TCP _Socket.c

b C TCPTestc ~
Solution Explorer [ ]

anaan

L7 Ready A AddtoSource Control + &3

11. Right click on the solution in the solution explorer and select Rebuild.

0 File Edt View Project Build Debug Test Analyze Tools FExtensions Window Help | Search Visual Studio (Ctrl-Q) P Netsim ® - o x

-0 B -2 WD C | Debug - x64 ~ b Local Windows Debugger ~ | 5% - 2 LiveShare &7

£ Solution Explorer - ax
: co@a-|o-s ol s-
2 Search Solution Explorer (Ctrl+;) p-
y R Solution ‘NetSim'[~y, -
g 4 [ Ethemet | ) Build Solution Ctrl+ Shift+B
g b =m References  Rebuild Solution

b ¥G ExtemalDe  Clean Solution

b C Ethemetc (T s

3 Ethemet.h .

b oC Ehemetel  BotchBuid.

b B Ethemetel  Configuration Manager...

b C EthemetM B Manage NuGet Packages for Solution...

b c Ethemet P [% Restore NuGet Packages

b c SpanningTy

o e
b C Switehmapl B New Solution Explorer View
b € Vienc Calculate Code Metrics
4 ETce 4 Retarget solution

b =m References

b i ExtemalDd  Project Dependencies...

b C Congestiof ProjectBuild Order...

b ¢ CUBICc e S

b C DelayedAc

b € ROc £} Set StartUp Projects...

b C SACKc | ) AddSolution to Source Control...

b SYN_flood|

R Paste Ctri+v

> @Tgh | Rename

b € TP.c | € OpenFolderin File Explorer

: B E: L Save As Solution Filter

c TCP_Appliq y -

b ¢ Tp.Con  Hide Unloaded Projects

b ¢ TCP_Enum Load Project Dependencies

b B TCPEnum S Properties Alt+Enter

b B TP :

b C TCP_incoming.c

b TCP_Networkinterface.c

b ¢ TCP_Outgoing.c

b C TCP_Packetc

b c TCP Socketc

b TCP Test. v

Solution Explorer [
ot support previewing A AddtoSource Control « &5

12. Upon successful build modified libTCP.dIl and libEthernet.dll file gets automatically updated in
the directory containing NetSim binaries. (Note: first rebuild the TCP project and then rebuild
the Ethernet project)

13. Run NetSim as Administrative mode.




Case-1: Without Malicious Node

1. Then DOS_Attack_Internetworks comes with a sample configuration that is already saved. To

open this example, go to Open Simulation and click on the DOS_Attack Case_1 that is

resent under the list of experiments as shown below:

\,}; MetSim Home

Version 12.1.21 (64 Bit)

New Simulation Ctrl+N

Ctrd+0

Cpen Simulation

Examples

License Settings

Exit

NetSim Standard

Metwork Simulation/Emulation Platform

Current workspace: DOS_Attack_Internetwork O\

Experiment name Date modified Network type

DOS_Attack_Case_3 06-05-2020 Internetworks '|I[
DOS_Attack Case 2 06-05-2020 Intermetworks '|I[
IDOS_Attack_Case_1 06-05-2020 Internetworks I TI[

mport Experiment

Workspace options...

Support

ct Technical Support
Email - support@tetcos.com

Documentation Contact us

Ernail - sales@tetcos.com
Phone - +91 767 603 4321

User Manual

2. The saved network scenario consisting of 2 Wired Nodes, 1 L2 Switch, 2 router, 1 Access
Point and 1 wireless node in the grid environment forming a internetworks Network. Traffic is

configured from Wired node to the Wireless node.
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4. In TCP.h set NUMBEROFMALICIOUSNODE as 1.

§‘ SYN._flood.c*
ré [ TCP vl (Global Scope)
s 43
3 44 #pragma comment (lib,"NetworkStack.lib")
= 45
g 46 _declspec(dllexport) target_node;
g 47
48
49 //USEFUL MACRO
58 #define isTCPConfigured(d) (DEVICE_TRXLayer(d) && DEVICE_TRXLayer(d)->isTCP)
51 #define isTCPControl(p) (p->nControlDataType/10@ == TX_PROTOCOL_TCP)
52
53 //Constant
54 #define TCP_DupThresh 3
55« | [idefine NUMBEROFMALTCIOUSNODE 1
56 int is_malicious_node(NETSIM_ID devid);

5. In SYN_FLOOD.c set malicious node as 0.

Ll SYN flood.c* + X &)
g,, [ TCP ~|  (Global Scope)
= 7 * Product or its content without express prior written consent of Tetcos is .
i 8 * prohibited. Ownership and / or any other right relating to the software and all *
= 9 * intellectual property rights therein shall remain at all times with Tetcos. .
S 10 i .
E 11 * Author: Soniya ¥

12 s s

13 e e B ST o

14

15 S#include "main.h"

16 #include "TCP.h"

17 #include "List.h"

18 #include "TCP_Header.h"

19 #include "TCP_Enum.h"

20 j

21 int malicious_node[NUMBEROFMALICIOUSNODE] = { @ };|

22 static void send_syn_packet(PNETSIM_SOCKET s);

23 //static PNETSIM_SOCKET socket_creation();

6. Based on whether you are using NetSim 32 bit or 64 bit setup you can configure Visual studio
to build 32 bit or 64 bit DIl files respectively as shown below:



04 File Edt View Project Buld Debug Test Anelyze Tools Extensions Window Help  SearchVivalStudio(Ctd-Q) O NetSim
f@-0|@-2 M| D¢ | Debug - x64 = b Local Windows Debugger ~ | 57 _
Win32

64

Configuration Manager...

xoqjo0L sat0dig ;AS

[ Ready

7. Right click on the solution in the solution explorer and select Rebuild.

= a X
& LiveShare &7

Solution Explorer

e 0
co@E-lo-c | L=
Search Solution Explorer (Ctrl+;)

5] Solution 'NetSim" (2 projects)
Pl Ethernet

13

3

*8 References
5 Extemal Dependencies
€ Ethemet.c

B Ethemeth

C Ethemet_enum.c

[ Ethemet_enum.h

C Ethernet Mac.c

C Ethemet Phy.c
 SpanningTiee.c

C© SwitchTable.c

=W References

& External Dependencies
Congestion.c
cuBIC.c
DelayedAck.c

RT0.c

SACK.c

SYN flood.c

TCB.c

A TCBh

© TP

B TcPh

¢ TCP_Applicationinterface.c
€ TCP_Connection.c

€ TCP_Enum.c

B TCP_Enumh

[ TCP_Headerh

€ TCP_Incoming.c
TCP_Networkinterface.c
TCP_Outgoing.c
TCP_Packet.c

TCP _Socket.c

© TCP Testc

Aannnnn

anaan

Solution Explorer [ ]

v X

P

A AddtoSource Control + &3

0 File Edt View Project Buld Debug Test Analyze Tools FExtensions Window Help | Search Visual Studio (Ctrl+Q) P Netsim ® - o
P0-0|B-2 WD - | Debug - x64 ~ b Local Windows Debugger - | 57 _ |2 LiveShare &7
g Solution Explorer v X
e oo & [
4 aom:‘ﬁ-\o-~@"\r@uﬁ\:‘\
s Search Solution Explorer (Ctrl+;) p-
: ko lisckibonNetan Build Soluti Ctrl+Shift+B
g 4 [ Ethernet Bz Build Solution trl+ -+
z b =m References Rebuild Solution
E b iG ExtemalDe  Clean Solution

b C Ethemetc Analyze »

» [ Ethemeth Batch Build...

b C Ethemet ef

b B Ethemetel  Configuration Manager...

b C EthemetM M Manage NuGet Packages for Solution...

b C Ethemnet P| [% Restore NuGet Packages

bC SpammingTl oy olorer Vi

b C SwitchTabl ew:olution Explores View

b € Vianc Calculate Code Metrics

4 TP Retarget solution

b =m References

b 15 ExtemalDd  Project Dependencies...

b C Congestiof ProjectBuild Order...

b c CUBICc Add S

b C DelayedAc|

b 6 Foe Set StartUp Projects.

b € SACKc |3 AddSolution to Source Control...

b SYN_flood|

= P 1+

b ¢ TBc aste Ctrl+V

> @TBh | Rename

b € TP @ Open Folder in File Explorer

> B TPh Save As Solution Filter

G I

> c TCPConni iide Unloaded Projects

b ¢ TCPEnum Load Project Dependencies

b [ TCPEnum| & Pproperties Alt+Enter

>

>

»

3

»

3

b

L7 This item does not support previ

AnnAnnnE

TCP_He

TCP_Incoming.c
TCP_Networkinterface.c
TCP_Outgoing.c

TCP_Packet
TCP_Socket
TCP_Test.c

Solution Explorer

23

13

4 Add to Source Control «

8. Upon successful build modified libTCP.dIl and libEthernet.dll file gets automatically updated in
the directory containing NetSim binaries. (Note: first rebuild the TCP project and then rebuild

the Ethernet project)
9. Run the simulation for 10 seconds.

2




Case-2: With one Malicious Node

1. Then DOS_Attack_Internetworks comes with a sample configuration that is already saved. To
open this example, go to Open Simulation and click on the DOS_Attack Case 2 that is
present under the list of experiments as shown below:

‘;E MetSim Home

NetSim Standard

Network Simulation/Emulation Platform
Version 12.1.21 (64 Bit)

License Settings

Exit

Workspace options...

Current workspace: DOS_Attack Internetwork O\ ‘
Mew Simulation Ctrl+N Experiment name Date modified Network type
DOS_Attack_Case_3 06-05-2020 Internetworks TI[
| Cpen Simulation Ctrd+0
IDOS,Attack,Casej 06-05-2020 Internetworks '|I[
Examples DOS_Attack_Case_1 06-05-2020 Internetworks TI[
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2. The saved network scenario consisting of 3 Wired Nodes, 1 L2 Switch, 2 router, 1 Access
Point and 1 wireless node in the grid environment forming a internetworks Network. Traffic is
configured from Wired node to the Wireless node.
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4. In TCP.h set NUMBEROFMALICIOUSNODE as 1.

§ SYN._flood.c*
ré [ TCP vl (Global Scope)
s 43
3 44 #pragma comment (lib,"NetworkStack.lib")
= 45
g 46 _declspec(dllexport) target_node;
g 47
48
49 //USEFUL MACRO
58 #define isTCPConfigured(d) (DEVICE_TRXLayer(d) && DEVICE_TRXLayer(d)->isTCP)
51 #define isTCPControl(p) (p->nControlDataType/10@ == TX_PROTOCOL_TCP)
52
53 //Constant
54 #define TCP_DupThresh 3
55« | [idefine NUMBEROFMALICIOUSNODE 1
56

int is_malicious_node(NETSIM_ID devid);

5. In SYN_FLOOD.c set malicious node as 8.

RS svn riood.c = x [

Ml TCP -|  (Global Scope)
13 Y i EbL
14
15 El#include "main.h"
16 #include “TCP.h"
17 #include “List.h"
18 #include "TCP_Header.h"
19 #include "TCP_Enum.h™
28
21 lint malicious_node[NUMBEROFMALICIOUSNODE] = { 8 };
22 static void send_syn_packet(PNETSIM_SOCKET s};
23 J/static PNETSIM _SOCKET socket_creation();
24 int target_node = 4;
25 PNETSIM_SOCKET get Remotesocket(NETSIM_ID d, PSOCKETADDRESS addr);
26 static PSOCKETADDRESS sockAddr = NULL;

6. Based on whether you are using NetSim 32 bit or 64 bit setup you can configure Visual studio
to build 32 bit or 64 bit DIl files respectively as shown below:



8.

9. Run the simulation for 10 seconds.
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b C SwitchTablec
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4 [B) TCP
b =B References
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b » References|  Rebuild Solution
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b [ Ethemete|  Configuration Manager..
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» BTeh | Rename
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oL Save As Solution Filter
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> ¢ TCP_Enum Load Project Dependencies
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Upon successful build modified libTCP.dIl and libEthernet.dll file gets automatically updated in
the directory containing NetSim binaries. (Note: first rebuild the TCP project and then rebuild

the Ethernet project)




Case-3: With two Malicious Node

1. Then DOS_Attack_Internetworks comes with a sample configuration that is already saved. To
open this example, go to Open Simulation and click on the DOS_Attack Case_3 that is

present under the list of experiments as shown below:

[ NetSim Home

NetSim Standard

Network Simulation/Emulation Platform
Version 12,1.21 (64 Bit)

New Simulation Ctrl+N

| Open Simulation Ctrl+0

Examples DOS_Attack_Case_1

License Settings

Exit

Workspace options...

Current workspace: DOS Attack Internetwork C\ |
Experiment name Date modified Network type
I DOS_Attack_Case 3 06-03-2020 Intemetworks por ]i[ I
DOS_Attack_Case_2 06-03-2020 Intemetworks por TiT
06-05-2020 Internetworks por i
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2. The saved network scenario consisting of 4 Wired Nodes, 1 L2 Switch, 2 router, 1 Access
Point and 1 wireless node in the grid environment forming a internetworks Network. Traffic is

configured from Wired node to the Wireless node.
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In TCP.h set NUMBEROFMALICIOUSNODE as 2.

§ SYN_flood.c*
é &l Tcp ~|  (Global Scope)
"Oi 43
3 44 #pragma comment (lib,"NetworkStack.lib™)
i 45
3 46 _declspec(dllexport) target_node;
g 47
438
49 //USEFUL MACRO
50 #define isTCPConfigured(d) (DEVICE_TRXLayer(d) && DEVICE_TRXLayer(d)->isTCP)
51 #define isTCPControl(p) (p->nControlDataType/10@ == TX_PROTOCOL_TCP)
52
53 //Constant
54 #define TCP_DupThresh 3
5s¢/ | #define NUMBEROFMALICIOUSNODE 2|
56 int is_malicious_node(NETSIM ID devid);
57 //Typedef
58 typedef struct stru_TCP_Socket NETSIM_SOCKET, *PNETSIM_SOCKET;
59

In SYN_FLOOD.c set malicious node as 8, 9.

s fioode” = [

Ml TCP -|  (Global Scope)
18 ®
11 * Author: Soniya
12 ®
13 _* ____________________________________________________________
14
15 El#include "main.h”
16 #include "TCP.R"
17 #include "List.h"
18 #include “TCP Header.h”
19 | #include "TCP_Enum.h"
28
21 Iirlt malicious node[ NUMBEROFMALICIOUSNODE] = {B, 9};
22 static void send syn_packet(PNETSIM SOCKET s);
23 f//static PNETSIM SOCKET socket creation();
24 int target _node = 4;

6. Based on whether you are using NetSim 32 bit or 64 bit setup you can configure Visual studio
to build 32 bit or 64 bit DIl files respectively as shown below:
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c TCP_Appli¢
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b ¢ TCP_Enum Load Project Dependencies
p: TCP_Enum &  Properties Alt+Enter
> B TP
b c TCP_incoming.c
b TCP_Networkinterface.c
b ¢ TCP_Outgoing.c
b TCP_Packetc
b c TCP Socketc
b TCP Test -
Solution Explorer | AL
[ This item does not support previewing A AddtoSource Control «  #3

Upon successful build modified libTCP.dIl and libEthernet.dll file gets automatically updated in

the directory containing NetSim binaries. (Note: first rebuild the TCP project and then rebuild

the Ethernet project)

9. Run the simulation for 10 seconds.

Result:

After simulation, open metrics window and observe the Application_Throughput is decreasing for both

applications as we increase the malicious node because of the SYN flood sends from the malicious

node, in case 1 there is no malicious node so there will be no SYN_FLOOD packets.




¥ Simulation Results

Queue_Metrics Detailed View Link_Metrics Detailed View
Deviceid Portid Queued packet Dequeued packet Dropped_packet Packet_transmi... Packet errored  Packet_collided
Link_id  Link_throughput_plot
5 1 0 0 0 Data Control Data Control Data Control
5 2 997 097 0 Al NA 4981 004 8 0
6 1 1 1 0 1 NA 500 o 1 0 0 0
6 2 995 995 0 2 NA 500 0 1 0 0 0
7 1 992 992 0 3 NA 998 o 2 0 0 0
4 NA 996 2 1 0 0 0
5 NA 995 ] 3 0 0 0
6 NA 992 992 0 0 0 0

Application_metrics Detailed View TCP_Metrics Detailed View
> Log Files Application Id  Application Name  Packet generated  Packet received Throughput (Mbps) Del{ Source Destination  SegmentSent Segment Received Ack Sent | Ack Received
1 App1_CBR 500 497 214 | WIRED_NODE_1 ANY_DEVICE 0 0 0 0
2 App2_CBR 500 495 210 | WIRED_NODE_2 ANY_DEVICE 0 0 0 0
WIRELESS_NODE 4 ~ ANY_DEVICE 0 0 0 0
ROUTER_S ANY_DEVICE 0 0 0 0
ROUTER_6 ANY_DEVICE 0 0 0 0

Restore To Original View

Throughput_APP1 Throughput_APP2
(Mbps) (Mbps)

Case-1: Malicious Node =0  0.580496 0.578160

Case-2: Malicious Node =1 = 0.520928 0.520928

Case-3: Malicious Node =2  0.287328 0.286160

Go to the result window open Event trace, user can find out the SYN_FLOOD packets via filtering
subevent type as SYN_FLOOD.

AutoSave P - Event Trace.csw = p Search A\ sagar khetagouda

File ﬂ Insert Page Layout Formulas Data Review View Help Table Design
E‘li' 4 Calibri W1V AA === 25 Wrap Text General - @ @ @ @ E @ -
Pafte [g - B I U-~ . === D o3 ~ 9% 9 eﬁg 438 F(;:;;iﬁ;r:lv F?r;r;'::tvas Stjil } \nsvert Delvete Foriﬂat
Clipboard M Font [} Alignment P Mumber [} Styles Cells
Al 7 S || Event_id
A g | C | D | E | F | G | H | [ | J | K
1 [Event Id| - |Event Type|~|Event Time[Us)|~|Device Type|~|Device Id[~]interface_1d|~]|Application_Id|~]|Packet Id[~]Segment Id[~|Protocol Name|~|Subevent Type|T]
124 | 1 TIMER_EVENT 1000 NODE 8 0 (1] o 0 TCP SYN_FLOOD
15{ 137 TIMER_EVENT 2000 NODE 8 0 0 o 0 TCP SYN_FLOOD
19; 168 TIMER_EVENT 3000 NODE 8 0 (1] 1] 0 TCP SYN_FLOOD
EIE 208 TIMER_EVENT 4000 NODE 8 0 0 o 0 TCP SYN_FLOOD
ZTE 231 TIMER_EVENT 5000 NODE 8 a o 0 0 TCP SYN_FLOOD
33E 292 TIMER_EVENT 6000 NODE 8 o} 0 o 0 TCP S¥YN_FLOOD
38»5 343 TIMER_EVENT 7000 NODE 8 a o 0 0 TCP SYN_FLOOD
445 400 TIMER_EVENT 8000 NODE 8 0 0 o 0 TCP SYN_FLOOD
495 455 TIMER_EVENT 9000 NODE 8 0 (1] 1] 0 TCP SYN_FLOOD
552 510 TIMER_EVENT 10000 NODE 8 0 0 o 0 TCP SYN_FLOOD
SS‘E 564 TIMER_EVENT 11000 NODE 8 a o 0 0 TCP SYN_FLOOD
651 612 TIMER_EVENT 12000 NODE 8 o} 0 o 0 TCP S¥YN_FLOOD
702 664 TIMER_EVENT 13000 NODE 8 a o 0 0 TCP SYN_FLOOD
755 715 TIMER_EVENT 14000 NODE 8 0 0 o 0 TCP SYN_FLOOD
81; 766 TIMER_EVENT 15000 NODE 8 0 (1] 1] 0 TCP SYN_FLOOD
865 827 TIMER_EVENT 16000 NODE 8 0 0 o 0 TCP SYN_FLOOD
S‘ZZ 876 TIMER_EVENT 17000 NODE 8 a o 0 0 TCP SYN_FLOOD
97£ 933 TIMER_EVENT 18000 NODE 8 o} 0 o 0 TCP S¥YN_FLOOD
1023 984 TIMER_EVENT 13000 NODE 8 a o 0 0 TCP SYN_FLOOD
IOEE 1035 TIMER_EVENT 20000 NODE 8 0 0 o 0 TCP SYN_FLOOD
1165 1082 TIMER_EVENT 21000 NODE 8 0 o] 1] 0 TCP S¥YN_FLOOD
_I_'!_’!S_—1_|_ﬂ,r\ TIMACD EHElIT‘ 200N RIANE o n n n nTCD (Vi NE S Wa¥alal

Note: Users can also create their own network scenarios in Internetworksand run simulation.



